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Computer Training: Where and 
Why To Get It
• Jeanne Cavanaugh

omputers are deeply embedded 
in the MIT landscape. Whether 

analyzing chemical compounds, ac- 
cessing the SAP financial system, or 
building a Web site, faculty, students, 
and staff use information technology 
(IT) to get results. 

Most people on campus try to stay 
current with computing trends that 
affect their work, from software re- 
leases to security issues. But as the 
role of IT has mushroomed, and as 
technology continues to change, how 
do individuals keep pace? Learning to 
use computers effectively is not some- 
thing that happens in our sleep.

IT Training Options 
There are several venues at MIT for 

learning about technology, whether you 
are a novice or more advanced user. 
Much of this training is offered at no 
charge. Some specialized courses are 
fee-based to recover their costs.

Financial Systems Services offers 
many courses on SAP. Topics range 
from using SAPweb for purchasing, 
to approving requisitions, to financial 
reporting. Note: SAP training is 
available only to MIT employees and 
affiliates designated to use SAP by 
their departments.

To find out more about SAP courses 
and to register online, go to
http://web.mit.edu/sapr3/training/ 

C

Information Systems offers hands-
on courses and Quick Start classes on 
Windows, Macintosh, and Linux appli- 
cations. The syllabus includes basics 
like getting connected to MITnet and 
virus protection. Many courses focus 
on application-specific skills, such as 
using spreadsheets and databases. 
More advanced topics run the gamut 
from LaTeX2e to Linux system and 
network administration. Most IS 
courses are open to any member of 
the MIT community.

To view IS course descriptions or 
to register online, go to
http://web.mit.edu/is/training/

IS offers Athena minicourses as 
well. While the main target audience is 
students, any member of the commu-
nity can take these minicourses. They 
are free and do not require preregistra-
tion. The minicourses are designed to 
show you how to get the most out of 
Athena, whether it’s a math software 
overview or a session on customizing 
dotfiles. For details on Athena mini-
courses, go to 
http://web.mit.edu/minidev/www/   

IS also sponsors web-based training 
through Element K. These online 
courses cover a range of Macintosh and 
Windows applications. Most Element K 
courses are self-paced, but some are led 
by instructors. To learn more, start at
http://web.mit.edu/is/training/wbt/

For a fee, IS offers one-on-one tutor- 
ials and group training for six or more 

http://web.mit.edu/sapr3/training/
http://web.mit.edu/is/training/
http://web.mit.edu/minidev/www/
http://web.mit.edu/is/training/wbt/
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COMPUTER TRAINING

continued from page 1

Keeping RSI at Arm’s Length: 
IS Supports Stretch Break 

Given the widespread use of com-
puters at MIT, it’s no surprise that 
repetitive strain injury (RSI) is taking 
its toll. RSI involves damage to muscles, 
tendons, and nerves caused by overuse 
or misuse. Working at a computer puts 
you at risk for RSI because part of your 
body is held in a static posture while 
other parts move constantly. 

Prevention is the best strategy. 
Stretch Break, from Para Technologies, 
is an ergonomic stretching and break 
timer program for Windows and Mac- 
intosh. The program reminds you to 
take periodic breaks from your com-
puter. A team of health care profes-
sionals developed Stretch Break to 
help increase circulation, relieve ten- 
sion, and guard against RSI. A series 
of 24 low-impact stretches are dis-
played at user-determined intervals. 
Stretch Break also provides ergonomic 
information, including workstation 
setup guidelines.

The program is especially helpful 
for anyone experiencing strain from 
computer use and for users who have 
trouble remembering to take breaks.

MIT Site License
Last year, the MIT Ergonomics Com- 

mittee bought a site license for Stretch 
Break 4 for the MIT community, and IS 
now supports this program. You can 
get the Stretch Break installer from 
http://mit.edu/software/ 

The Macintosh version is 4.1; the Win-
dows version is 4.5. Before installing, 
review the documentation at
http://mit.edu/atic/www/stretch/ 

Getting Help
If you have a question about Stretch 

Break or need assistance with the pro- 
gram, send e-mail to the Computing 
Help Desk at <computing-help@ 
mit.edu> or call x3-1101 (Macintosh) 
or x3-1102 (Windows).

For more information about repeti-
tive strain injury, see
http://web.mit.edu/atic/rsi/ ø 

people in a department. A group class 
can save money and result in more 
focused training.

If none of these venues offers the 
computer course you are looking for, IS 
has a referral policy with several local 
training groups and can help match 
your request with the right vendor.

Comprehensive Catalog
To find out more about learning 

opportunities on campus, browse 
MIT’s Training and Development catalog, 
due in mailboxes in early September. 
This catalog details courses offered by 
over a dozen groups on campus – from 
the Benefits Office to Environmental 
Health and Safety. 

Benefits of IT Training
Many people know about the train-

ing opportunities on campus, but can’t 
find the time to attend because other 
priorities are too pressing.

It may be time to rethink those pri- 
orities. There are compelling reasons 
for employees and managers to make 
time for training. The first and most 
obvious reason is to reap the benefits of 
increased efficiency. When individuals 
learn about software features or how 

to make technology transitions (for 
example, migrating to a new operating 
system), they soon recoup the time 
spent in training by doing their work 
more efficiently. Training can reduce 
the number of steps it takes to accom-
plish a task, as well as the number of 
errors users are likely to make. Training 
may even provide “Aha!” moments, 
demonstrating automated ways to do 
repetitive tasks. 

In preparing a course, developers 
spend hours exploring software, and 
make a point of focusing on features 
that align with the work of MIT depart- 
ments. Guidance from an instructor 
offers many of the same benefits as 
having a native tour guide show you 
around a foreign country. 

Training also provides a way to stay 
current with technology trends. When 
new MIT services such as WebMail or 
the Events Calendar are introduced, a 
Quick Start class can get you up and 
running in short order. 

Organizational Benefits
As an institution of higher educa-

tion, MIT puts a premium on learning 
and development. This type of culture 
encourages flexibility and responsive-
ness to change.

Most employees at the Institute 
thrive in an environment of continual 

learning. Training opportunities equip 
them to maintain high levels of perfor- 
mance while enhancing job satisfaction. 
Recent studies have shown that work- 
places that make an above-average 
investment in training and develop-
ment have lower rates of voluntary 
attrition. This bucks the old belief that 
training employees encourages them 
to jump ship. Given the cost of recruit-
ing new employees and getting them 
up to speed, investing in training is a 
sound move. 

It is true that as employees’ profes-
sional skills develop, they may seek 
more responsibility or move into other  
roles. This is part of healthy profes-
sional development. But employees 
who change roles or departments at 
MIT are still at MIT, and the profes-
sional skills they take with them are 
highly transferable. Since MIT’s suite 
of recommended software and enter-
prise systems such as SAP are in use 
across the Institute, technology skills 
transfer exceptionally well. 

Keeping up with changes in tech- 
nology is critical to MIT’s mission. It is 
also instrumental in making the most 
of a tightening budget. Wise use of 
technology is one way of doing more 
with less. Technologically savvy 
employees are an equally important 
part of the equation. ø 

http://mit.edu/software/
http://mit.edu/atic/www/stretch/
http://web.mit.edu/atic/rsi/
http://web.mit.edu/is/isnews/
http://web.mit.edu/is/newslink/
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The Brushes palette gives you many options 
for experimenting with brushes. You can 
preview a brush stroke in the lower pane.

Adobe Photoshop 7 Enhances 
Creativity and Productivity
• Robyn Fizz

dobe Systems recently released 
Photoshop 7 for Windows and 

Macintosh. This version of Adobe’s 
image-editing software offers a File 
Browser for managing images and new 
tools for painting, retouching, and 
correcting color. Better options for out-
putting to the Web come courtesy of 
ImageReady 7, a companion program 
that’s part of the package. Also with 
this release, Photoshop is now compat-
ible with Windows XP and Mac OS X.

As has always been the case with 
Photoshop, the more muscle your ma- 
chine has, the better. This version re- 
quires 128MB of RAM (192MB recom-
mended) and 280MB of available hard 
disk space (320MB for Macintosh).

File Browser 
Photoshop’s new File Browser lets 

you view images as thumbnails with- 
out opening them. You can quickly lo- 
cate and organize images on your hard 
drive, other drives, and CDs. Within 
this utility, you can create new folders; 
rename, move, and delete files; and ro- 
tate images. The Batch Rename feature 
lets you rename multiple files at once. 
Note that transformations applied in 
the File Browser stay in effect when 
you open an image.

The File Browser has four panes 
that you can customize. 
• The Tree view lets you navigate disks 

and folders that contain images.
• The Thumbnail pane displays the 

images, letting you choose among 
five size options. The Small Thumb-
nail option lets you see the most 
images at once. At the other end, the 
Large Thumbnail with Rank option 
lets you see larger views ranked in 
an order you determine. For example, 
you could mark images as “original,” 
“proof,” or “final,” then sort by 
those criteria.

 • The Preview pane displays a selected 
image in a larger size.

• The Metadata pane provides details 
about a selected image, such as date 
created and modified, file size, file 
format, and color mode. It also 
includes file information from 
digital cameras.

Retouching Tools
While the File Browser wins high 

marks for utility, the Healing Brush 
Tool is probably Photoshop 7’s most 
eye-opening new feature. The Healing 
Brush lets you easily remove artifacts 
such as dust, scratches, blemishes, and 
wrinkles. Unlike the Clone Stamp 
Tool, the Healing Brush automatically 
preserves shading, lighting, texture, 
and other attributes when cloning 
within one image or from one image 
to another. 

Related to the Healing Brush (and 
sharing the same space on the Tools 
palette) is the Patch Tool. It does the 
same work as the Healing Brush, but 
on selections and channels.

Painting Engine
Photoshop’s new painting engine 

gives users more creative options. It 
can realistically simulate traditional 
painting techniques such as pastels 
and charcoal, as well as wet and dry 
brush effects. Using the Brushes pal-
ette, you can adjust settings for shape, 
texture, and many other attributes, 
and save those settings as custom 
brush presets.

You can also create new painting 
effects by combining two different 
brushes. 

Color Correction
Photoshop’s new Auto Color 
command lets you adjust the 
contrast and color of an image, 
offering reliable, one-step color 
correction. It does a good job of 
removing color casts. Move over, 
Auto Levels.

ImageReady 7
ImageReady, the companion 
application to Photoshop, lets 
you create image maps, slices, 
animations, and rollover buttons 
for the Web. Some of the new 
features in ImageReady include: 
• Rollovers palette – This palette 
displays all the image maps, 
slices, rollovers, and animations 
in a file, giving you a convenient 
overview of the various docu-
ment states. 
• Remap transparencies – You can 
now make web page elements 

transparent by clicking on the color 
you want to exclude. You can remap 
more than one color at a time and 
restore the original settings. 

• Dither transparencies – This option 
lets you create partial transparent 
effects. You can easily blend web 
graphics into backgrounds, even 
patterned ones.

• Preview wireless device images – You 
can now preview and save for the 
Web in WBMP format, commonly 
used for displaying images on PDAs 
and cell phones. WBMP images 
contain only black and white pixels.  

Purchase and Support
You can purchase Photoshop 7 at 

an academic discount through Gov-
Connection. The academic price is 
$259.41. An upgrade from a previous 
version costs $139.95.

To get the discount, begin at
http://web.mit.edu/ecat/
govconnection/

Certificates are required.
IS offers limited support for Photo- 

shop, primarily through training. As 
of October, beginning and advanced 
Photoshop courses taught in W89 will 
use the newest version of the software. 
For details about these courses, see the 
Computer Training page at
http://web.mit.edu/is/training/ ø  

http://web.mit.edu/ecat/govconnection/
http://web.mit.edu/is/training/
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Windows XP at MIT
Information Systems plans to announce 
support for the latest Microsoft opera- 
ting system, Windows XP, toward the 
end of August. The initial support will 
include documentation on configuring 
Windows XP for the network, printing, 
security, and user interface enhance-
ments. The Computing Help Desk will 
be ready to provide assistance. IS will 
soon offer training courses for system 
administrators, similar to those given 
in the past for Windows NT and 2000. 

IS has purchased a Windows XP 
license. IS strongly recommends that 
when you buy new machines, you buy 
them with Windows XP Professional. 
Windows XP Home Edition lacks much 
of the functionality used at MIT. 

IS is doing something new with the 
release of support for Windows XP –
that is, testing applications outside the 
IS Support Suite such as Matlab and 
Photoshop. To provide the best service 
possible, IS will focus its resources on 
Windows 2000 and XP by retiring old 
versions of Windows as follows:
• Windows ME Dec. 31, 2002
• Windows 98/98SE June 30, 2003
• Windows NT 4.0 June 30, 2003
If you have questions regarding the 
future of Windows at MIT or the 
Windows retirement plans, contact 
Jonathan Hunt at <jmhunt@mit.edu>.

Other Software News
IS recently announced support for the 
following software:
• Eudora 5.1 (Windows & Mac OS X)
• Fetch 4.0.2 (Macintosh)
• Kerberos for Mac 4.0.1 (Macintosh)
• Netscape 6.2.3 (Windows and   
 Macintosh)
• Stretch Break 4.x (Windows and  
 Macintosh)
• Virex 7.x (Mac OS X)
• WinZephyr 1.0 (Windows)
To download these programs and 
others, visit 
http://web.mit.edu/software/

For information concerning upcoming 
software releases, see 
http://web.mit.edu/swrt/ ø 

The Lowdown on Spam: 
No Solutions Yet in Sight
• Mark Van Dyke

ou may have noticed a lot more 
pointless e-mail in your inbox 

lately. These messages tout schemes to 
get rich quick, or pills to look younger, 
or deals on toner cartridges – or offers 
that are even less savory. Who are these 
people and how did they get your  
address? For the unscrupulous senders 
of these messages, e-mail is a form of 
cheap advertising, a venue for scam-
ming people, or a way to shock or 
annoy.

What Is Spam?
Unsolicited bulk e-mail is often 

referred to as spam, an unfortunate use 
of the Hormel Corporation’s luncheon 
meat of the same name. The key word 
here is unsolicited: spam, like junk 
mail, is not something that you asked 
for. It appears in your inbox (often 
multiple times), taking your attention 
away from relevant work-related and 
personal e-mail. Spam costs millions 
of dollars a year in lost time, due to 
slower bandwidth, attempts to filter, 
and frustration.

Unfortunately, spammers are get-
ting cleverer. They get your address 
in a variety of ways. Many harvest 
addresses from Usenet postings and 
web pages, by viewing mailing list 
archives, or by buying them from com-
panies that claim to have the address 
owner’s permission. Once spammers 
have a collection of addresses, sending 
the mail is easy.

Dealing with Spam
Many users have tried to filter 

out spam based on certain keywords 
found in the subject line and header, or 
based on the particular address or host 
of a known spammer. Such filtering 
techniques are less effective now that 
software is available that lets spam-
mers slightly modify the subject and 
content of the message with each send. 
This lets spam slip through most filters 
undetected. By the time you’ve seen 
the message, recovered from its con- 
tent, and created a filter, the spammer 
has already begun to send a slightly 
modified message. 

In addition, spammers rarely give 
an accurate return address. If the ad- 

dress is valid, it’s likely that of some 
unlucky third party. This has created 
some interesting battles that rarely 
include the person who actually sent 
the message. While IS still encourages 
people to use the filtering mechanisms 
in their e-mail programs, it’s not likely 
to wipe out spam completely.  

What to Do
When you get spam, check to see 

where it came from by viewing the 
full header. To do this in Eudora, click 
the BLAH BLAH BLAH button. Examine 
the Received from: field to see where 
the message originated, since the From: 
field can be easily forged. If the mail 
came from within MIT, ask “Is this 
spam, or did the person simply make a 
misstep in terms of the list’s purpose?” 
If the message has been sent from 
within MIT to a list that you’re on, 
you may want to check with your list 
administrator to see if the message 
violates posting rules of the list. You 
can reach list administrators by sending 
e-mail to <owner-listname@mit.edu>, 
where listname is the name of your list. 
If the message was sent to the list in 
error, the sender should be sent a 
reminder of the list posting rules. 
Mass mailing or blind carbon copying 
many unrelated lists at MIT is a form 
of spam and should be reported to 
<stopit@mit.edu>.   

If the mail originated outside of 
MIT, there is less that MIT can do.  
MIT does not attempt to filter its mail 
both for privacy reasons and because 
it is usually ineffective. Deleting the 
message is your best course of action. 
Turning off e-mail previewing also 
lets you delete offensive messages 
without having to view the content. 
IS does not recommend responding to 
the message, visiting the web site, or 
calling the phone number provided to 
be removed from the distribution list. 
Doing so only confirms that your e-
mail address is accurate and may sub- 
ject you to unsightly web sites, long 
distance phone charges, or more spam.

While the recent state of affairs with 
regard to spam has not been bright, 
there are legitimate organizations 
working to combat it through proposed 
legislation, spam reporting, and better 
filtering options. IS continues to inves- 
tigate such methods and hopes to be 
able to provide a workable solution to 
the spam problem soon. ø

Y

This column presents announcements 
about IS-supported software. For more 
information about recent releases, see 
http://web.mit.edu/swrt/

http://web.mit.edu/swrt/
http://web.mit.edu/software/
http://web.mit.edu/swrt/


M C C / C o m p u t e r  C u r r e n t s

•     July / August 2002    •    http://web.mit.edu/is/isnews/4 
. 
. 
.
. 

i/s 5
. 
. 
. 
. 

i/shttp://web.mit.edu/is/isnews/    •    July / August 2002    •    

A

Not Just for Students: Back- 
to-School Laptop Specials
• Kathleen Moriarty 

pple, Dell, and IBM are offer-
ing discounted prices on the 

recommended laptops for incoming 
freshmen. Other MIT students, faculty, 
and staff are also eligible to purchase 
these products at the special pricing.

Apple Offerings
Apple has deals on 
the PowerBook G4 
and both iBooks. 
All three models 

include an Airport card for wireless 
networking, a combo drive that reads 
and writes CDs and plays DVDs, and 
a one-year warranty. 

The PowerBook G4 is a lightweight, 
high-performance system. It boasts a 
15.2-inch megawide display powered by 
the ATI Mobility Radeon 7500 graphics 
processor, and it weighs just 5.4 pounds. 
The bundle includes a 667MHz Power- 
PC G4 processor, 512MB of RAM, and 
a 30GB hard drive. The G4 laptop is 
priced at $2349.

The iBook is a less expensive alter- 
native for users who require less power. 
Both iBook configurations include a 
700MHz PowerPC G3 processor. The 
bundle with a 12-inch display ships 
with 256MB RAM and a 20GB hard 
drive for $1389. You can move up to a 
14-inch display, 384MB of RAM, and 
a 30GB hard disk for $1713.

Deals from Dell
Dell has discounts on two Latitude 

models – the C840 and C610. Both come 
with built-in wireless networking, CD-
RWs, and Windows XP Professional. The 
three-year warranty includes Complete- 
care, which covers accidental damage.

The C840 is a true desktop replace-
ment, with a Pentium 4M processor 
running at 1.6GHz. It features a 15-inch 
UXGA display powered by the Nvidia 
GeForce 440 GoTM video card with 
32MB of video RAM. The promotion 
includes 512MB of RAM and a 20GB 
hard drive. This model weighs in at 
7.4 pounds and is priced at $2190.68.

The C610 is a midrange notebook, 
with a 1GHz Pentium III processor and 
14-inch XGA display. It weighs just 4.9 
pounds. It includes 256MB of RAM 
and a 20GB hard drive for $1861.23.

IBM Specials
IBM has back-to-school pricing on 

the ThinkPad T30 and ThinkPad R32. 
Both models include a Pentium 4M 
processor, CD-RW/DVD combo drive, 
built-in wireless networking, Windows 
XP Professional, and a three-year 
warranty.

The ThinkPad T30, with its titanium 
chassis, is a high-performance system 
at an excellent price. The bundle is 
configured with a 1.6GHz P4 processor, 
a 14-inch XGA display, 256MB of RAM, 
and a 40GB hard drive for $1959. You 
can upgrade to a ThinkPad T30 with 
an SXGA+ display and a 1.8GHz pro- 
cessor for $2156.82. This model weighs 
5.7 pounds.

The ThinkPad R32 sports a 14-inch 
XGA display and weighs 6.2 pounds. 
The bundle includes a 1.6GHz P4 pro-
cessor, 128MB of RAM, and a 30GB 
hard drive for $1759.79.

Full Specs
For configuration details or order-

ing instructions, go to
http://web.mit.edu/mcc/www/

or contact an MCC consultant at 
x3-7686 or <mcc@mit.edu>. ø

New IS Service: House Your 
Servers in a Secure Environment 
• Dave Lambert

s your department getting more 
dependent on that server you 

maintain under your desk? Are you 
annoyed to find that the custodian has 
inadvertently tripped over the power 
cord on your departmental NT server? 
Are you greeted, on return from your 
vacation, with comments about the 
two-day outage of your server after a 
power failure? Information Systems 
now provides a service that may make 
your life a bit easier.

Collocation Service
This past year IS introduced a 

service that provides a low-cost option 
for housing your server in a secure 
environment with uninterrupted and 
backup emergency power. This service 
uses MIT’s existing administrative 
Data Center in Building W91.

This service, called collocation 
(sometimes spelled colocation), gets 
its name from industry. In the past, 
server-hosting vendors co-located 
their equipment with Internet back-
bone service providers.

The W91 Data Center is staffed 
around the clock, with the exception of 
weekend nights, holidays, and special 
Institute closings. Staff are on call for 
emergencies during normally unstaffed 
periods. The service includes basic 
computer operator “eyes and hands.” 
That means an authorized person can 
remotely request a system reboot or 
a power cycle to reset the server – 
possibly saving a trip to campus and 
increasing the server’s availability.

The “eyes and hands” service also 
provides the ability to swap backup 
tapes for your server. Additionally, 
your backup tapes can be moved to a 
media storage facility outside of W91.

Network connectivity is provided 
via 100MB/second switched connec-
tions to MITnet’s backbone.

The Data Center is equipped with 
a large 225 kilovolt amp uninterrupt-
ible power supply and a 400 kilowatt 
diesel generator with redundant 13.8 
kilovolt (kV) utility power feeds and 
redundant 13.8kV transformers.

On the mechanical side, the facility 
is equipped with 100-ton chiller towers, 
chiller compressors, and air condition-
ing units. This equipment ensures that 
the facility stays at 72º Fahrenheit 
(plus or minus two degrees). 

To find out more about the service, 
including rates, contact Dave Lambert 
at x3-7095 or <lambert@mit.edu>, or see 
http://web.mit.edu/is/dost/
collocation.html

Server Management
IS also provides a full set of services 

to manage servers in the Data Center. 
Standard system administration sup- 
port and Oracle database services are 
included in this offering. For more 
information, contact Peter Kelley at 
x3-6323 or <kelley@mit.edu>. ø
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Eudora Power Tips

Eudora is MIT’s supported POP e-mail 
client. Even if you use Eudora every 
day to check your e-mail, you may not 
be taking full advantage of the applica- 
tion. Try the following tips, condensed 
from the Eudora User Manual. For more 
insights into Eudora, download the 
manual from
http://www.eudora.com/
techsupport/manuals.html

Making the Most of Searches
You may be familiar with Eudora’s 

Find command, which allows a simple 
search of your current mailbox. But 
Eudora also has a Search command 
that lets you search multiple mail-
boxes simultaneously.  
1. On Windows, choose Edit>Find> 

Find Messages. On the Macintosh, 
choose Special> Find>Search. 

2. At the top of the window, select the 
conditions you want to use in your 
search. For example, if you want to 
look for any e-mail that references 
events@mit.edu anywhere in the 
message, choose Anywhere from 
the first drop-down menu, contains 
from the second drop-down menu, 
and then type events@mit.edu in 
the blank text field.

3. Choose the Mailboxes tab.
4. Select which mailboxes you want to 

search. On Windows, use the check 
boxes to select or deselect those mail 
boxes you wish to search. On the 
Macintosh, to search more than one 
mailbox, hold down the Shift key 
while selecting. To search all of 
your mailboxes, click the topmost 
Eudora Folder icon. If you want to 
search all but one or two mailboxes, 
click the Eudora Folder icon and 
then, while holding down the Shift 
key, click the mailboxes you don’t 
want to search to deselect them. 

5. Click the Search button.
You will see your search results in 

the Results tab. If you want to modify 
your search, click the Mailboxes tab 
and repeat steps 1 through 5.

Using Filters
Many of Eudora’s e-mail manage-

ment functions can be automated with 
a filter, which performs certain opera- 
tions on your messages behind the 
scenes. You can set up filters for in- 
coming or outgoing messages, or both.

On incoming messages, filters let 
you do such things as the following:
• Transfer all the messages from 

friends into a Personal mailbox.
• Play a special sound when you 

receive a message from someone 
important.

• Change the label color to red for 
important e-mail messages.

As an example, you can move all the 
messages from <goodeats@yum.com> 
(a fictional restaurant review mailing 
list) to a mailbox called Good Eats so 
that you can review these messages 
later. That way they don’t fill up your 
In mailbox. To create a simple filter 
that automatically transfers messages 
to another mailbox, do the following:
1. Select or open the e-mail message 

that contains the information you 
want to use to create the filter.

2. Choose Special>Make Filter.
3. Check the fields of the Make Filter 

dialog box to make sure the informa- 
tion is the way you want it, and edit 
it if necessary. For example, select the 
incoming check box because you 
want all incoming messages to go to 
the Good Eats mailbox. Then choose 
the From contains radio button 
(From on Windows) and make sure 
the corresponding field lists the 
<goodeats@yum.com> e-mail 
address. Next, in the Action area, 
choose Transfer to new mailbox 
and in the corresponding field type 
Good Eats to name your mailbox.

4. Click Create Filter to add this filter 
to your list of filters. If you want to 
make your filter more detailed, or 
have it do other actions, click Add 
Details. This opens the Filters 
dialog box, where you can further 
refine the filter.

Downloading Message Headers 
Only
If you are checking mail over a slow 

network connection, you can down-
load just the message headers instead 
of the entire message.  

Why is this useful? Message headers 
show you the From:, To:, Subject:, and 
Cc: fields, as well as whether there are 
any attachments. This lets you scan 
messages in your In mailbox without 
waiting for the entire batch – including 
attachments and spam – to download. 
You can then mark messages for down- 
load or deletion. 

Here are the steps to follow to 
download message headers:
1. On Windows, hold down the Shift 

key and choose File>Check Mail. 
On the Macintosh, hold down the 
Option key and choose File>Check 
Mail Specially. The Mail Transfer 
Options dialog box appears.

2. Select the check box Fetch all mes-
sage headers to In mailbox. This 
will retrieve the header and the 
first few lines of every message in 
your In mailbox. If you use filters, 
the messages are filtered but any 
“Copy To” or “Transfer To” filter 
action is not performed (the mes-
sage is not copied, nor does it leave 
the In mailbox).
When you open the message head- 

ers, you will notice two icons in the 
toolbar of the message window. One 
is a trash can. The other is an arrow. If 
you click the trash can, the next time 
you check mail, this message will be 
deleted on the server and will not be 
downloaded to your In mailbox. If you 
click the arrow, the entire message 
will be downloaded.

You will also see a warning in the 
body of the message, indicating that 
the remainder of the message has not 
been transferred, and instructing you 
on what to do to retrieve the message. 

If you mark a header to be down-
loaded, Eudora will receive the entire 
e-mail as a separate message. It will 
not replace the downloaded header. 
Similarly, if you mark a header for de- 
letion, it will delete the message from 
the server but will not delete the down- 
loaded header from your In mailbox.

Deleting the header without mark-
ing it for download or deletion will do 
the same thing as marking the mes-
sage for download. ø

This column presents tips and answers 
to frequently asked technology questions. 
For extensive Q&As, check the IS Stock 
Answers database at
http://hdstock.mit.edu/stockanswers/

http://hdstock.mit.edu/stockanswers/
http://www.eudora.com/techsupport/manuals.html
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Custom Calendar Lets You 
Post Events on the Web
• Phyllis Galt

sing a calendar service developed 
by IS, you can post events on the 

MIT Events Calendar at
http://events.mit.edu/  

and have them display automatically in 
a calendar on your web site. You also 
have the option to specify that events 
display only on your custom calendar. 
And, if you choose, you can post other 
groups’ events from the MIT Events 
Calendar on your calendar.

To see a custom calendar in use, go 
to the Aero/Astro example at
http://events.mit.edu/example/

Benefits
With this new service, you can 

create a department or group calendar 
in a few hours, without having to pay 
an outside firm to do it. 

Using the calendar templates, you 
can produce a custom calendar that is 
consistent with your web site’s look 
and feel. The templates let you specify 
colors and fonts, and place a logo or 

other custom elements in the calendar. 
You can change the templates any time 
your web site changes.  

An Overview of the Process
To create and post to a custom cal- 

endar, you first need to be authorized. 
If your group is already authorized to 
post events to the MIT Events Calendar 
and you know someone in the group 
who can post events, that person can in 
turn authorize you. If you don’t know 
who in your group is authorized, you 
can request this information by sending 
e-mail to <events-admin@mit.edu>. 
If your group is not yet authorized to 
post events, you may ask to have it 
added by submitting the form (certi-
ficates required) at
https://events.mit.edu/
secscripts/groupadd.pl 

There are two calendar templates 
that you can download and use: 
• A traditional calendar grid showing 

events for one month.
• A detailed view of a single event.

Both pages have a navigation bar 
used for switching the events display 
from one month to another. 

A cascading style sheet controls 
colors and fonts. To make changes, you 
will need experience building web pages 
and editing style sheets. For guidance, 
refer to Publishing on the Web at 
http://web.mit.edu/cwis/
publishing.html

Once your templates are ready, the 
next step is to upload them to a web 
server. You may want to store them in 
the same directory you use for your MIT 
web site. 

Finally, in your web site, add a link 
to the full URL of the directory in 
which you placed the template files. 
At this point you will also specify the 
group whose events you want to 
display – usually your own group, 
though you can display events from 
other groups as well. Voilà! Your 
calendar is now viewable on the Web. 

Instructions and Help  
For complete instructions on setting 

up a custom events calendar, go to
http://web.mit.edu/is/help/
events/custom.html  

If you need help along the way, 
contact the Computing Help Desk at 
x3-1102 or <web-help@mit.edu>. ø

The ATIC Lab Is Moving to a 
New Campus Location
• Kathy Cahill

n late August, the ATIC (Adaptive 
Technology for Information and 

Computing) Lab will relocate from its 
space in Building 11 to Room 7-143, just 
down the hall from Lobby 7. In the new 
location, ATIC will be next to a satellite 
area of the Disabilities Services Office 
(DSO), making it more convenient for 
students with disabilities to access 
DSO and ATIC services. 

The ATIC Lab provides computing 
solutions for MIT students and staff 
with disabilities. The ATIC Lab space 
serves as an alternative computing 
cluster for students with disabilities 
who need access to special technolo-
gies, such as voice recognition, alter-
native keyboards and mice, screen 
reading, magnification, Braille transla-
tion and embossing, and scan-and-read 
software. 

Students registered with Disabilities 
Services can sign up to use the ATIC 
Lab, receiving keycards that allow 
access to the Lab 24 hours a day.

What’s New?
ATIC’s new location provides some 

natural light and greater privacy for 
students doing their work. The Lab is 
fully accessible to wheelchair users and 
has adjustable equipment and furni-
ture. A sit-stand workstation lets users 
sit or stand at a computer, as needed.

Areas of Expertise
The ATIC Lab is staffed by consul-

tants Monday through Friday from 9 am 
to 5 pm. ATIC staff provide guidance to 
MIT departments, labs, and centers on 
how to make their web sites more acces- 
sible to people with disabilities. ATIC 
staff also have specialized knowledge 
about computer access for those with 
vision impairments, repetitive strain 
injury, learning disabilities, and other 
conditions that impact user interactions 
with computers. 

ATIC consultants also demonstrate 
adaptive technologies to MIT faculty 
and staff by appointment. Staff at the 
MIT Computer Connection (MCC), in 
the lower level of the Student Center, 
demonstrate a subset of ATIC’s alter- 
native keyboards and mice, as well as 
voice recognition products. Both ATIC 
and the MCC maintain an inventory 
of keyboards and pointing devices 
that are available for a three-day loan 
period to MIT community members.

Open House, Getting in Touch
ATIC will soon announce plans for 

an open house to invite members of 
the MIT community to visit its new 
location and see demonstrations of 
various kinds of adaptive technologies. 
For up-to-date information, go to the 
ATIC Lab web site at
http://web.mit.edu/atic/www/

You can reach ATIC by calling x3-
7808 or sending mail to <atic@mit.edu>. 
To contact the MCC, call x3-7686 or 
send mail to <mcc@mit.edu>. ø
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S u r f  S i t e s :  R e s o u r c e s  f o r  P h o t o g r a p h e r s

If you don’t know where to get help 
for your computer, network, or 
telephone problems, dial one of the 
help lines listed to the right.

If you prefer to use e-mail, you 
can send your questions to the cor-
responding e-mail addresses on the 
far right. (When logged into Athena, 
you can also use the olc command 
to send questions to Athena’s online 
consultants.)

For a complete list of services 
offered by Information Systems, see 
http://web.mit.edu/is/services/

The newest version of Photoshop pro- 
vides even more tools for editing and 
enhancing photographs (see the Soft- 
ware Spotlight on page 3). For tips on 
using Photoshop and other Adobe 
programs, visit the Adobe Studio at
http://studio.adobe.com/

At this site, you will also find online 
galleries, tutorials, and free downloads.

Many other sites on the Web focus 
on photography, covering everything 
from camera reviews to techniques 
to photojournalism. There are even   
forums where you can post and cri-
tique photographs. To sample some of 
what’s out there, visit the sites listed to 
the right.  

Camera Works (the day and week in photos)
http://www.washingtonpost.com/wp-dyn/photo/

Digital Photography Review
http://www.dpreview.com/

photo.net
http://www.photo.net/

Photography at about.com
http://photography.about.com/ 

PhotoSIG: Photo Critique and Discussion Forum
http://www.photosig.com/

PhotographyTips.com
http://www.photographytips.com/

ZoneZero (from analog to digital photography)
http://www.zonezero.com/

For help with… Dial… Or send a message to…

Administrative applications 2-1177 business-help@mit.edu
Athena Computing Environment 3-4435 olc@mit.edu
Computer and printer repairs 3-0815 hardserv@mit.edu
Computer pre-sales consulting 3-7686 mcc@mit.edu
Disabilities and computing 3-7808 atic@mit.edu
Macintosh computers 3-1101 mac-help@mit.edu
(including network problems)
PC computers 3-1102 pc-help@mit.edu
(including network problems)
Telephone repairs 3-4357 5help@mit.edu
UNIX/VMS (by subscription) 3-1103 unix-vms-help@mit.edu
Voice mail 3-3677 vmail@mit.edu
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